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LIST OF TABLES
Table 1 – This table is provided as an example.

By utilizing Word’s “Insert Caption…” feature, you can easily build your List of
Tables (this page) and List of Figures (following page). To streamline the formatting
of the “List of Tables,” the label and number, caption, and page number appear in
columns 1, 2, and 3, respectively, of the table above. If you cannot see the table
gridlines, select the table, go to the “Layout” menu and select “View Gridlines.”
In the first column, you can insert the Label and Number of a Figure by using the
“Cross-Reference” tool in the “References” menu. Click “Cross-reference,” select
“Figure” or “Table” from the drop-down menu, and select the desired information to
be included from the drop-down menu “Insert reference to:” In the second column,
the corresponding figure caption should be inserted. In the final column, insert the
page number.
To update all fields prior to submitting your document, simply select the table, right
click the text, and select “Update Field.”
DELETE THIS INSTRUCTIONS TEXT BOX BEFORE PRINTING.
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LIST OF FIGURES
Figure 1 – This is a figure.
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LIST OF SYMBOLS AND ABBREVIATIONS
A the letter A
B the letter B
C the letter C
D the letter D

Note: Special Character must be at the end.

ABSTRACT
The technological advances in electronic and software have been rapidly assimilated by
computer systems, demanding new approaches for software and systems engineering to
provide reliable products, under well-known quality criteria. In this context, requirements
engineering has a strategic role in project development. Problems in the elicitation
activity contribute to producing poor, inadequate or even non-existent requirements that
can cause mission losses, material or financial disasters, premature project termination or
promote an organizational crisis. This thesis introduces the elicitation process for
dependability goals, called ELICERE, applied to critical computer systems based on a
goal-oriented requirement engineering technique, called i*, and the safety engineering
techniques HAZOP and FMEA, which will be applied for the identification and analysis
of operational risks of a system. After creating the system models using i* diagrams, they
are analyzed through guidewords based on HAZOP and FMEA, from which goals related
to dependability are extracted.
DELETE THE ABOVE TEXT BUT BE SURE TO RETAIN THE SPACING.

The Summary is the last of the Preliminary pages.
The Summary may have the same content as the doctoral Abstract but the format is
different. The Abstract is an external document you prepare for GIK Institute. The
Summary is part of the body of your work and so the Summary must have the same
spacing as the body of the thesis (generally double-spaced).
DELETE THIS INSTRUCTIONAL TEXT BOX WHEN DONE.

CHAPTER 1.
CHAPTER 2.
2.1

<HEADING LEVEL 1: BOLD, TIMES NEW ROMAN 14 >

Introduction <Heading Level 2: Bold Time New Roman 12>
English: UK English
Text of the Body: Times New Roman 12
Line Space: 1.5
Paragraph Space: Before 12: After 10
Paper Margin: Top: 0.8, Bottom: 1, Left: 1, Right: 0.8
Page Number: Centralized at the Bottom of the page with the page 1 starting from Chapter 1.

The pages prior to chapter 1 (such as certificate, content list, abstract etc.,) will get roman page
numbers centralized at the bottom of each pages
2.2

How to Use This Template [This is a First-Level Subheading]
The first-level subheading utilizes the “Heading 2” quick style. Using this style will include

your first-level subheading in the Table of Contents. This template file has been set up to meet the
formatting requirements for theses and dissertations given in the GIK Institute Graduate Thesis
Manual. It's not magic, but it does get some of the confusing stuff taken care of: the margins are
correct; the table of contents is formatted correctly; the necessary parts are in the right order; the
page numbers will appear in the right place and in the right form; it has an acceptable font face and
size. Further, Appendix A has a description of the scheme for subheadings you should use if your
departmental style guide doesn't specify one.
2.2.1 This is a Second-Level Subheading (Heading Level 3: Times New Roman 12, Italic)
Second-level subheadings utilize Heading 3. It will be pretty obvious when you need to get
rid of some text in this template. For example, this part of the introduction needs to go before you
start typing. Easiest way to delete it is to click your cursor in front of the first paragraph, scroll
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down to the last line in the chapter, hold the SHIFT key down, and click after the last letter. 'SHIFTclicking' like this selects everything between the two clicks.
2.2.2 Inserting and Numbering Equations
To insert an equation to be referenced in the text, use the three-column table shown below.
This table has been added to the “Auto Text” menu accessed through “INSERT”  “Quick Parts.”
Equations are generally described and referenced in the text as is done in the following sentence.
Equation 1 below describes the relationship between the need for a vacation,
available time to take a vacation,

, and the

. The equation number (1) that appears in the table is a

sequential field code which allows equation numbers to update automatically by right-clicking
highlighted text and selecting “Update Field.” When adding an equation, select the number and
bookmark it under the “INSERT” menu.

When you reference the equation in the text (i.e.

“Equation 1 describes something”) you can insert that bookmark so numbers will automatically
update.

(1)

2.2.3 Inserting, Numbering, and Referencing Figures
When you insert an image into the text, it will look like Figure 1 below. In the previous
sentence, a figure reference is inserted by cross-referencing the figure label and number (INSERT
 Cross-reference  Reference Type: Figure  Select figure entry and choose Insert reference to:
Only label and number).

Figure 1 – This is a figure. The “caption” uses the “Caption” theme from the quick styles
menu above and is added by right-clicking the figure and selecting “Insert Caption...”
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2.2.4 Inserting, Numbering, and Referencing Tables
After a table is inserted, it must be captioned by selecting the Table and right clicking. Then
click on “Insert caption…” The process is similar for captioning a figure except for the fact that a
Table’s caption appears ABOVE the table as opposed to the figure caption appearing below a
figure. An example of a table is given in Table 1 below. By inserting the cross-reference to the
table (i.e. Table 1), the numbering will be done automatically.
Table 1 – This table is provided as an example.

A

B

C

1
2
3
4

5
6
7
8

9
10
11
12

2.2.5 Things to be Careful of
You can goof up the template. For example, when you delete the text on a page, be careful
not to accidentally delete the marker, called a 'page break,' between the chapters or different types
of pages. The page break marker makes your new chapter begin at the top of a page, no matter what
editing you do before them. .If you delete a section break, related to a page break, you may lose any
formatting that was particular to that page.
2.2.5.1 Using Tabs Correctly [This is a Third-Level Subheading]
When you put your headings into the Table of Contents, List of Tables, etc. things should
line up pretty well if you use tabs to skip to the next column. If you use spaces to indent or move to
the next column, you will have a mess. As spaces in most font families are not fixed in size, things
won’t necessarily line up perfectly and you may be required to fix it. Moreover, when you use
spaces rather than tab settings to determine placement of text, any change in words, fonts, or
margins requires a great deal of work to reformat. If you use tab settings to control placement,
making such changes becomes trivial.
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Because of the way tabs are set, if a chapter title or section name in the Table of Contents is
very short, you may have to put an extra tab character to get the cursor to jump correctly.
2.2.5.2 Using the Styles
The page and section heading styles have been set up as named styles in Word. The page
headings in the preliminary pages (e.g. “Table of Contents”), each chapter heading (e.g. “Chapter 1:
Introduction”), and the back page headings (e.g. “References”) all use a style called “Heading 1“.
The first-level subheadings (example above) use a style called “Heading 2”. The second-level
subheadings use a style called “Heading 3”. The third-level subheadings use a style called “Heading
4”. If you accidentally delete any of those headings, go to the Format/Style menu, select the
appropriate style and “Apply”. If you cannot find the style under the list of styles, change the pulldown below it called “List” to “All styles”.
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CHAPTER 3.

SETTING UP A NEW CHAPTER

How do you begin a new chapter using this template? What must you do to get the page
numbers to act correctly? Below are the steps for making a new chapter.
3.1

Moving to a New Chapter
To move to a new chapter, you must tell Word that you are moving on to a new page. You

do this by inserting a page break. A page break forces the next line of text to appear at the top of a
fresh page.
3.1.1 How to Insert a Page Break
1. Go to the end of a chapter. That means, put your cursor after the very last character of
that chapter.
2. Hit Return to move to a new paragraph.
3. From the Insert menu, choose Page Break.
If you are in Outline View (see View menu), you'll see a dotted line across the screen. That
marks the end of the previous page. If you are in Page Layout view, you'll just see the top of a new
blank page.
Begin typing. If you are in Page Layout view, when you get to the end of the first page, your
text will skip to the next page. A page number will appear at the bottom center of the new page. The
number will be gray, and you can't edit it. That's OK; that is the way it's supposed to look on the
screen.
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APPENDIX A. DESCRIPTION OF DEFAULT SUBHEADING SCHEME
This appendix illustrates the default style of subheadings as described in the Graduate
Studies Thesis Manual, available at http://www.grad.gatech.edu/thesis. Your department may have
its own style guide and its own way of formatting subheadings. Whichever scheme you use, you
must use it consistently throughout the document or the Graduate Thesis Office will require you to
make revisions until it is acceptable.
The default format for chapter-level headings is bold, all upper case, and centered.
Otherwise the font is the same font family and the same size or no more than 2 font points larger
(e.g. 14 points vs. 12).
A.1 First-Level Subheading
The default format for first-level subheadings is left-justified, bold, and upper and lower
case (UC/LC) . Alternatively, you may use plain (not bold), and all upper case (UC). The former
of the two is built into this Word document. In either case, it should be the same size as the text
font. If you use upper/lower case, capitalize words as you usually would in a title.
A blank line above the subheading has already been built into this template so it is not
necessary to leave another blank line before headings so long as you are using the proscribed
heading and subheading styles. Styles were discussed in Chapter 1 of this document.
A.1.1 Second-Level Subheadings
Second-level headings are also justified left. If the first-level subheading was UC/LC and
bold, the second-level subheading will be UC/LC and italicized. That is the style built into this
Word document.
Since a blank line above each subheading was built into this template, it is not necessary to
leave another blank line before headings so long as you are use the proscribed subheading style.
A.1.1.1 Third-Level Subheadings
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Third-level subheadings are plain UC/LC text and underlined. Capitalize as with the other
subheadings.
A.1.1.1.1

Fourth-Level Subheadings

Fourth-level subheadings, if needed, should be plain UC/LC text, flush left.
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REFERENCES

It is highly recommended that you use some sort of reference manager when using the
Word template. Alternatively, you can use the reference functionality of the
Microsoft World
If your discipline utilizes a different display format (e.g. references listed at the end of
each chapter), you may do so. But it is preferred that they all appear at the end of the
document on this REFERENCES page.

REFERENCES STYLE SHOULD BE IEE
The thesis should follow IEE Style for references. Some examples as per IEE style are given
below.
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